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AKVIS ENHANCER 17.5 | BILDKORREKTUR UND DETAILOPTIMIERUNG

Wenn Sie ein Foto einer schwarzen Katze in einem dunklen Raum machen, kann das Ergebnis alles andere als ideal sein. Oder
wenn Sie ein Foto von einem schönen Ausblick machen, aber die automatischen Einstellungen sich auf dem Himmel fokussieren
und die Aufnahme ungleich belichtet ist - der Himmel ist wunderschön, aber der Rest ist dunkel und unklar.

AKVIS Enhancer ist eine Bildverbesserungssoftware, die jeden Bereich des Bildes individuell behandelt! Das Programm bietet
eine schnelle Methode, um die generelle Qualität Ihrer Fotos zu verbessern: dunkle Fotos aufhellen, Details herausholen,
Kontrast und Helligkeit erhöhen, Farbton anpassen.

Die Software bietet drei Modi - Detailoptimierung, Druckvorbereitung und Tonkorrektur. Das oberste Ziel dieser Modi ist
das gleiche - Bildkorrektur, aber die Methoden und die Ergebnisse sind unterschiedlich. Verschiedene Bilder erfordern
Anwendung unterschiedlicher Modi, die in vielen Fällen einander ergänzen.

Im Modus Detailoptimierung verdeutlicht das Programm die Zeichnung des Bildes, indem es den Farbübergang zwischen den
benachbarten Pixeln verstärkt. Auf diese Weise werden nicht nur Details im Schatten, sondern auch Details in den
überbelichteten Bereichen und in den Mitteltönen aufgedeckt. Das ist der schnellste und einfachste Weg, dunkle Fotos zu
retten.

Im Modus Druckvorbereitung können Sie Ihre Fotos für den Druck optimieren, indem Sie die Konturenschärfe und den
Kontrast erhöhen. Dadurch gewinnt der Abdruck an Deutlichkeit. Selbst ein qualitativ hochwertiges Foto muss für den Druck
vorbereitet werden, um ein professionelles Aussehen zu erhalten.

Der Tonkorrektur-Modus korrigiert die Helligkeit der Pixel in hellen und in dunklen Bereichen, sodass das Bild an Ausdruck
gewinnt. Man kann das ganze Bild bearbeiten oder nur bestimmte Farben auswählen, die Korrekturen brauchen.

Holen Sie das Beste aus Ihren Fotos mit AKVIS Enhancer heraus!
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Das Programm ist nicht nur für die Korrektur der Familienfotos und Kunstfotografien geeignet. Es kann sich auch für
spezielle Zwecke als nützlich erweisen. Die Herausgeber der technischen Literatur können AKVIS Enhancer anwenden, um
technische Illustrationen (Maschinen, Mechanismen) in allen Einzelheiten zu zeigen. Ärzte können AKVIS Enhancer anwenden,
um die Detailgenauigkeit von Röntgenaufnahmen zu verbessern.

AKVIS Enhancer ist intuitiv bedienbar und erschließt sich selbst Einsteigern ohne stundenlanges Studium des Handbuchs. Sie
können häufig verwendete Einstellungen als Presets speichern. Es optimiert Ihre Arbeit und spart Zeit.

Das Programm unterstützt  Stapelverarbeitung von Bildern. Sie brauchen nur einmal die Einstellungen anzupassen und
danach wird das Programm den ganzen Stapel der Fotos automatisch bearbeiten.

AKVIS Enhancer

4

https://akvis.com/de/enhancer-tutorial/examples/technical-illustration.php?utm_source=help


Das Programm steht in zwei Versionen zur Verfügung - als eigenständiges Programm (Standalone) und als Zusatzprogramm
(Plugin). Weiter…

Die Standalone-Version erlaubt es Ihnen, die Nachbearbeitungseinstellungen für weitere Bildkorrektur zu benutzen:
Veränderung von Helligkeit, Kontrast, Gamma und Sättigung.

Die Plugin-Version ist mit AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro funktionstüchtig, sowie mit
anderen Bildbearbeitungsprogrammen, die Plugins von Drittanbietern integrieren. Mehr Information finden Sie auf der Seite
Kompatibilität prüfen.

Während der Probezeit können Sie alle Funktionen der Software ausprobieren.
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SO INSTALLIERT MAN AKVIS SOFTWARE

Folgen Sie der Anweisung, um das Plugin AKVIS Enhancer unter Windows zu installieren.

Starten Sie die Windows Setup-Datei (mit .exe-Dateiendung).
Wählen Sie die Sprache aus und klicken Sie auf Installieren, um den Installationsvorgang zu starten.
Um den Installationsvorgang fortzusetzen, müssen Sie die Lizenzbedingungen durchlesen und akzeptieren.

Aktivieren Sie das Kontrollkästchen "Ich stimme den Bedingungen der Lizenzvereinbarung zu" und klicken Sie auf
Weiter.

Um das Plugin zu installieren, wählen Sie Ihre Bildbearbeitungssoftware aus der Liste aus.

Um die Standalone-Version zu installieren, stellen Sie sicher, dass das Kontrollkästchen Standalone aktiviert ist. 
Um eine Verknüpfung des Programms auf dem Desktop zu erstellen, aktivieren Sie den Punkt  Verknüpfung auf
Desktop.

Klicken Sie auf die Schaltfläche Weiter.

Klicken Sie auf die Schaltfläche Installieren.

AKVIS Enhancer

7



Die Installation ist gerade im Gange.

Die Installation ist beendet.

Sie können AKVIS Newsletter abonnieren, um Informationen über neue Produkte und spezielle Angebote aus erster
Hand zu erhalten. Geben Sie Ihre Email-Adresse ein.

AKVIS Enhancer

8



Klicken Sie auf Fertig stellen, um das Setup zu beenden.

Nach der Installation der Standalone-Version von AKVIS Enhancer sehen Sie einen neuen Eintrag im Menü Start: AKVIS -
Enhancer. Auf dem Desktop erscheint das Symbol der Verknüpfung, wenn Sie während der Installation das Kästchen
Verknüpfung auf Desktop aktiviert haben.

Nach der Installation der Plugins-Version von Enhancer sehen Sie einen neuen Eintrag im Filter/Effekte-Menü Ihrer
Bildbearbeitungssoftware. Z.B. in Photoshop: Filter -> AKVIS –> Enhancer.
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SO INSTALLIERT MAN AKVIS SOFTWARE

Um AKVIS Enhancer unter Mac zu installieren, folgen Sie den Anweisungen:

Öffnen Sie die virtuelle dmg-Disk:

- akvis-enhancer-app.dmg, um die eigenständige Standalone-Version zu installieren.

- akvis-enhancer-plugin.dmg, um die Plugin-Version in einem Bildbearbeitungsprogramm zu installieren.

Lesen Sie die Lizenzvereinbarung und klicken Sie auf Akzeptieren, wenn Sie die Bedingungen annehmen.

Finder öffnet sich und Sie sehen einen Ordner mit Dateien: AKVIS Enhancer Application oder AKVIS Enhancer
Plugin.

 

Um die Standalone-Version zu installieren, ziehen Sie AKVIS Enhancer Application in den Ordner Programme oder
ein Verzeichnis Ihrer Wahl.

Um die Plugin-Version zu installieren, ziehen Sie den ganzen Ordner AKVIS Enhancer Plugin in den Plug-Ins Ordner
Ihres Bildbearbeitungsprogramms:

Pfad für  Photoshop CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5:
Library/Application Support/Adobe/Plug-Ins/CC.

Pfad für Photoshop CC 2015: Applications/Adobe Photoshop CC 2015/Plug-ins.

Pfad für Photoshop CS6: Applications/Adobe Photoshop CS6/Plug-ins.
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AKVIS Plugins unter Mac
(klicken um zu vergrößern)

Nach der Installation des Plugins AKVIS Enhancer sehen Sie einen neuen Eintrag in dem Filter/Effekte-Menü Ihres
Bildbearbeitungsprogramms: AKVIS -> Enhancer. Z.B. in dem Menü von Photoshop wählen Sie den Befehl: Filter - AKVIS -
Enhancer.

Führen Sie die Standalone-Version aus, indem Sie im Finder auf das entsprechende Symbol doppelklicken.

Sie können das AKVIS-Programm auch über die  Photos-App ausführen, indem Sie den Befehl  Bild -> Bearbeiten mit
auswählen (in High Sierra und späteren Versionen von macOS).
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SO AKTIVIERT MAN AKVIS SOFTWARE

Achtung! Während des Aktivierungsvorgangs muss Ihr Computer mit dem Internet verbunden sein.

Wenn Ihr Computer keinen Internetzugang hat, bieten wir Ihnen eine alternative Aktivierungsmöglichkeit an (siehe unten
Aktivierung ohne Internetzugang).

 

Laden Sie AKVIS Enhancer herunter und installieren Sie das Programm. Bevor Sie mit der Installation beginnen, lesen Sie die
Installationsanleitung.

Jedes Mal, wenn Sie eine unregistrierte Version starten, wird das Anfangsfenster angezeigt. Hier finden Sie allgemeine
Informationen über die Version des Programms und die Anzahl der restlichen Tage bis zum Ablauf der Testzeit.

Außerdem können Sie das Fenster Über das Programm öffnen, indem Sie auf die Schaltfläche   in der Optionsleiste des

Programms klicken.

 

Klicken Sie auf TESTEN, um die Software zu evaluieren. Ein neues Fenster mit Lizenz-Varianten zum Testen wird angezeigt.

Sie können das Programm ohne Anmeldung und Registrierung während der Testperiode ausprobieren (10 Tage nach dem ersten
Start).

Während der Testperiode können Sie alle Optionen testen und entscheiden, welcher Lizenztyp Ihren Bedürfnissen am besten
entspricht. Wählen Sie eine der angebotenen Lizenztypen: Home (Plugin oder Standalone), Home Deluxe, oder Business.
Die Funktionalität des Programms hängt von einem Lizenztyp ab. Für eine detailliertere Übersicht konsultieren Sie bitte die
Vergleichstabelle.

 

Klicken Sie auf KAUFEN, um eine Lizenz zu bestellen.

Sobald die Zahlung erfolgt ist, erhalten Sie Ihre persönliche Seriennummer an Ihre E-mail-Adresse innerhalb weniger Minuten.

 

Klicken Sie auf AKTIVIEREN, um den Aktivierungsvorgang zu starten.
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Geben Sie Ihren Namen ein (das Programm wird auf diesen Namen registriert).

Geben Sie Ihre Seriennummer (Ihren Lizenzschlüssel) ein.

Wählen Sie eine Aktivierungsmethode — entweder direkte Verbindung zum Aktivierungsserver oder per E-Mail.

Direkte Verbindung zum Aktivierungsserver:

Es ist die einfachste Möglichkeit der Aktivierung.

Bei dieser Aktivierungsmethode muss Ihr Computer mit dem Internet verbunden sein.

Drücken Sie auf AKTIVIEREN.

Die Aktivierung ist nun abgeschlossen!

Aktivierungsanfrage per E-Mail senden:

Falls Sie die Aktivierung per E-Mail ausgewählt haben, erstellt das Programm eine Nachricht mit allen notwendigen
Informationen.

HINWEIS: Sie können diese Methode auch bei der Aktivierung ohne Internetzugang nutzen.

Wenn Ihr Computer nicht mit dem Internet verbunden sind, übertragen Sie die Aktivierungsanfrage auf einen anderen
Computer mit Internetzugang, z.B. per USB-Stick. Senden Sie uns diese Anfrage an: activate@akvis.com.

Bitte senden Sie keine Screenshots! Man muss den Text einfach kopieren und speichern.

Wir brauchen Ihre Seriennummer für die Software, Ihren Namen und Hardware ID (HWID) Ihres Computers.

Eine Lizenzdatei (Enhancer.lic) wird erstellt und Ihnen per E-Mail übersendet.

Speichern Sie die erhaltene .lic-Datei auf einen USB Stick und verlegen sie auf den Computer, auf welchem Sie das
Programm aktivieren möchten. Öffnen Sie die Datei nicht! Legen Sie die Lizenzdatei im AKVIS-Ordner ab:

Windows 7/8/10:

Users\Public\Documents\AKVIS;

Mac:

Users/Shared/AKVIS.

Die Aktivierung ist nun abgeschlossen!
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Nach der Aktivierung wird die Schaltfläche KAUFEN durch die Schaltfläche UPGRADE ersetzt. Mithilfe dieses Buttons können
Sie Ihre Lizenz verbessern (beispielsweise Home-Lizenz auf Home Deluxe oder Business upgraden).
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ARBEITSBEREICH

AKVIS Enhancer ist ein Werkzeug, um Bilder zu retten, die wegen falscher Belichtung nicht optimal aussehen. Die Software
steht in Standalone- und Plugin-Version zur Verfügung.

Standalone ist ein eigenständiges Programm. Klicken Sie auf das Piktogramm des Programms, um es zu öffnen.

Um die Standalone-Programmversion zu starten:

Unter Windows - wählen Sie das Programm in dem Start-Menü oder benutzen Sie die Verknüpfung des Programms
auf dem Desktop.

Unter Mac - starten Sie die Software aus dem Programmordner.

Plugin ist ein Zusatzmodul zur Integration in ein Bildbearbeitungsprogramm, z.B. in Photoshop.

Um das Plugin aufzurufen, wählen Sie es im Filter-Menü Ihres Bildbearbeitungsprogramms.

Der Arbeitsbereich von AKVIS Enhancer sieht so aus:

Arbeitsbereich von AKVIS Enhancer, Ergebnis-Register

Das Bildfenster mit den Registern Original und Ergebnis nimmt den größeren Teil des Programmfensters ein. Das Originalbild
wird im Original-Fenster und das bearbeitete Bild im Ergebnis-Fenster angezeigt.

Sie können wählen, wie sich das Bildfenster mit dem Foto und die Original/Ergebnis-Fenster angezeigt werden, indem Sie
die Ansichtsmodi im unteren Teil der Werkzeugpalette anpassen.

 

Im oberen Teil des Fensters befindet sich die Optionsleiste mit den folgenden Schaltflächen:

Die Schaltfläche   öffnet die Produktseite von AKVIS Enhancer im Internet.

Die Schaltfläche   (nur in der Standalone-Version) öffnet ein Bild zur Bearbeitung. Der Hotkey ist  Strg+O  auf

Windows, ⌘ +O  auf Mac.

Mit einem Rechtsklick auf  werden die zuletzt geöffneten Dateien angezeigt. Sie können die Zahl der zuletzt

geöffneten Dateien in den Optionen festlegen.

AKVIS Enhancer
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Die Schaltfläche   (nur in der Standalone-Version) speichert das bearbeitete Bild. Der Hotkey ist Strg+S  auf

Windows, ⌘ +S  auf Mac.

Die Schaltfläche   (nur in der Standalone-Version) druckt das bearbeitete Bild aus. Der Hotkey ist Strg+P  auf

Windows, ⌘ +P  auf Mac.

Die Schaltfläche   erlaubt es, die Bilder aus dem Programm in sozialen Netzwerken zu veröffentlichen.

Die Schaltfläche   lädt die Liste der Presets (aus der .enhancer Datei).

Die Schaltfläche   speichert Presets in eine separate Datei mit der Endung .enhancer.

Die Schaltfläche   (nur in der Standalone-Version) öffnet das Dialogfenster Stapelverarbeitung, um eine Serie der

Bilder automatisch mit den gleichen Einstellungen zu bearbeiten.
Die Schaltfläche   (nur im Druckvorbereitung- und Tonkorrektur-Modus) startet die Bearbeitung des Bildes.

Mit der Schaltfläche   wird das Ergebnis der Korrektur angewendet und das Fenster des Plugins AKVIS Enhancer

wird geschlossen.
Die Schaltfläche   ruft Informationen über das Programm auf.

Die Schaltfläche   ruft die Hilfe auf. Der Hotkey ist F1 .

Die Schaltfläche   ruft das Dialogfenster Optionen auf.

Die Schaltfläche   öffnet ein Fenster mit den neuesten Nachrichten über Enhancer.

 

Links vom Bildfenster befindet sich die Werkzeugpalette:

Die Schaltfläche   (nur im Druckvorbereitung-  und Tonkorrektur-Modus) aktiviert das Vorschaufenster-

Werkzeug.
Das Freistellen-Werkzeug  (nur in der Standalone-Version verfügbar) erlaubt es, überflüssige Teile des Bildes

wegzuschneiden. Das Werkzeug kann verwendet werden, um die Bildkomposition zu verbessern, ein schiefes Bild
auszurichten, ein horizontales Foto in ein vertikales Foto umzuwandeln und umgekehrt.
Das Verschieben-Werkzeug  wird verwendet, um den angezeigten Bereich des Bildes im Fenster zu verschieben,

wenn das ganze Bild in das Fenster bei diesem Maßstab nicht passt. Um das Bild zu scrollen, klicken Sie auf diese
Schaltfläche, bringen Sie den Cursor auf das Bild und verschieben Sie das Bild bei gedrückter Maustaste.

Mit einem Doppelklick auf die Schaltfläche   wird die Abbildung der Programmfenstergröße angepasst.

Das Zoom-Werkzeug  ändert den Maßstab des Bildes. Um den Maßstab zu erhöhen, aktivieren Sie die Schaltfläche

und klicken Sie das Bild an. Um den Maßstab zu verringern, klicken Sie auf das Bild bei gedrückter Alt -Taste.

Mit einem Doppelklick auf die Schaltfläche   wird die Abbildung in ihrer Originalgröße (100%) dargestellt.

 

Das vorläufige Ergebnis wird automatisch im Vorschaufenster im Original-Register angezeigt. Im Navigator-Fenster kann
man das Bild skalieren. Der rote Rahmen zeigt den Bereich des Bildes, der im Bildfenster angezeigt wird. Wenn Sie den roten
Rahmen über das Bild verschieben, ändert sich der sichtbare Bereich im Bildfenster. Um den roten Rahmen zu verschieben,
bringen Sie den Cursor in den Rahmen hinein und ziehen Sie den Rahmen bei gedrückter Maustaste.

Außerdem ist es möglich, das Bild im Bildfenster zu scrollen, indem Sie die Leertaste auf der Tastatur drücken und das Bild
mit der linken Maustaste ziehen. Benutzen Sie das Mausrad, um das Bild nach oben und nach unten zu verschieben; wenn die
Strg -Taste gedrückt wird, wird das Bild nach links oder nach rechts verschoben; wenn die  Alt -Taste gedrückt wird, kann
man das Bild skalieren. Mit einem Rechtsklick auf die Bildlaufleiste wird das Menü Schnellnavigation geöffnet.

Mit dem Schieberegler können Sie die Skalierung des Hauptbildes ändern. Indem Sie den Schieberegler nach rechts
verschieben, vergrößern Sie das Bild; indem Sie den Schieberegler nach links verschieben, verringern Sie das Bild im
Bildfenster.

Sie können auch einen Wert in das Feld eingeben.

Auch mit den Tasten +  und Strg++  (⌘ ++  unter Mac) können Sie die Skalierung erhöhen und mit  -  und Strg+-  (⌘ +-

AKVIS Enhancer

16



unter Mac) die Skalierung verringern.

 

Unter dem Navigator-Fenster befindet sich die Einstellungsleiste, in der Sie den gewünschten Arbeitsablauf und Parameter
für Bildbearbeitung auswählen können.

Im Presets-Bereich kann man die aktuellen Einstellungen speichern, um sie später zu verwenden. Nach dem Start des
Programms werden die Einstellungen des zuletzt benutzten Presets verwendet.

Unter der Einstellungsleiste werden die Hinweise für Parameter und Buttons angezeigt, über die Sie mit dem Cursor gehen.
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ANSICHTSMODI

Es gibt drei Schaltflächen am Ende der Werkzeugspalette, die bestimmen, wie das Bildfenster dargestellt wird.

Ein Klick auf den ersten Button öffnet ein Untermenü mit verschiedenen Optionen wie das Original und das Ergebnis
angezeigt werden sollen:

- Die Schaltfläche   bietet das Standard-Bildfenster mit den Registern Original und Ergebnis.

- Die Schaltflächen   und  erzeugen ein zweigeteiltes Bildfenster (je nach Auswahl vertikal oder horizontal

geteilt). Das Originalbild und die bearbeitete Fassung sind teilweise zu sehen. Die Original- und Ergebnis-Register
sind zusammengelegt und erzeugen so das ganze Bild.

Sie können den Splitter verschieben und dadurch das Seitenverhältnis zwischen Registern Original und Ergebnis
ändern.

- Die Schaltflächen   und  teilen das Bildfenster ebenso in zwei Hälften (vertikal oder horizontal). Im

Gegensatz zur vorherigen Option zeigen sie jedoch den selben Ausschnitt des Bildes im Original und nach der
Bearbeitung an.

Hinweis: Es ist hilfreich, zwei Fenster nebeneinander zu benutzen wenn Sie sowohl das Originalbild als auch die
bearbeitete Version auf einem Monitor sehen und vergleichen möchten. Wenn Sie es bevorzugen, das Resultat im
Ganzen zu sehen, dann wählen Sie das Standard-Bildfenster.

Die Schaltfläche   tauscht die Positionen des Original- und Ergebnisbildes (wenn zwei Fenster nebeneinander zu

benutzen).
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Die dritte Schaltfläche lässt Sie die Hintergrundfarbe des Bildfensters bestimmen. Ein Klick auf  ,  und  ändert

die Hintergrundfarbe in Weiß, Grau oder Schwarz, während ein Klick auf   den Farbauswahldialog öffnet, in dem Sie

die Farbe ihrer Wahl bestimmen können.
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VORGEHENSWEISE

AKVIS Enhancer steht in zwei Versionen zur Verfügung - als eigenständiges Programm (Standalone) und als Zusatzprogramm
(Plugin).

Folgen Sie diesen Schritten, um das Bild mit AKVIS Enhancer scharfzustellen:

Schritt 1. Öffnen Sie ein Bild in dem Programm.

- Wenn Sie mit der eigenständigen Version arbeiten:

Öffnen Sie das Dialogfenster Bild öffnen mit einem Doppelklick auf den leeren Arbeitsbereich des Programms oder
mit einem Klick auf . Benutzen Sie die Hotkeys: Strg+O  auf Windows, ⌘ +O  auf Mac. Sie können auch das

gewünschte Bild einfach in den Arbeitsbereich des Programms mit der Maus ziehen.
Die eigenständige Version von AKVIS Enhancer unterstützt die folgenden Formate: JPEG, TIFF, BMP, PNG und
RAW.

- Wenn Sie mit der Plugin-Version arbeiten:

Öffnen Sie ein Bild in Ihrem Bildbearbeitungsprogramm mit dem Befehl Datei -> Öffnen.

Rufen Sie das AKVIS Enhancer-Plugin auf:

in AliveColors: Effekte -> AKVIS -> Enhancer; 
in Adobe Photoshop und Photoshop Elements: Filter -> AKVIS -> Enhancer; 
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> Enhancer; 
in Corel Photo-Paint: Effects -> AKVIS -> Enhancer.

Schritt 2. Wählen Sie den passenden Modus aus dem Drop-down-Menü in der Einstellungsleiste.
Im Modus Detailoptimierung verdeutlicht das Programm die Zeichnung des Bildes, indem es die Farbenübergange
verstärkt. Dies bedeutet, dass AKVIS Enhancer den Unterschied zwischen den angrenzenden Pixeln, die
unterschiedliche Farbabstufungen haben, verstärkt. Infolgedessen werden nicht nur Details im Schatten, sondern
auch Details in den überbelichteten Bereichen und in den Mitteltönen aufgedeckt.
Im Modus Druckvorbereitung können Sie die Schärfe der Konturen und den Kontrast des Bildes vor dem Drucken
erhöhen. Dadurch gewinnt der Abdruck an Deutlichkeit.
Der Modus Tonkorrektur wird für die Tonkorrektur von Bildern angewendet. Dabei wird die Helligkeit der Pixel in
hellen und in dunklen Bereichen so geändert, dass das Bild an Ausdruck gewinnt. Man kann das ganze Bild
bearbeiten oder nur bestimmte Farben auswählen, die Korrekturen brauchen.

Hier finden Sie einen Vergleich der Modi.

Schritt 3. Passen Sie die Parameter an:
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Schritt 4. Wenn Ihnen die vorgenommenen Einstellungen gefallen, so können Sie diese als Preset speichern und später
wieder verwenden. Dafür tragen Sie einen Namen für das Preset in das  Presets-Feld ein und betätigen den Knopf
Speichern.

Wenn der Cursor über ein Preset aus der Drop-down-Liste bewegt wird, erscheint eine Schnellansicht im  Preset-
Vorschaufenster.

Um ein Bild mit einem bestimmten Preset zu bearbeiten, wählen Sie einfach das Preset aus der Liste.

Beim nächsten Start des Programms werden diese Einstellungen standardmäßig verwendet. Um die ursprünglichen
Einstellungen des Programms wiederherzustellen, klicken Sie auf Rücksetzen.

Um ein Preset zu löschen, wählen Sie diese aus der Liste und klicken auf die Schaltfläche Löschen.

Schritt 5. Für die weitere Bildkorrektur verwenden Sie das Register Nachbearbeitung.
Schritt 6. Sie können Ihre Kunstwerke teilen, indem Sie auf   klicken. Über diese Funktion kann man Bilder direkt aus

dem Programm auf sozialen Netzwerken veröffentlichen.

Die eigenständige Version von AKVIS Charcoal erlaubt das Drucken  des Bildes.
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Schritt 7. Speichern Sie das Bild.

- Wenn Sie mit der eigenständigen Version arbeiten:

Klicken Sie auf , um das Dialogfeld Speichern unter zu öffnen. Sie können die Hotkeys benutzen:  Strg+S

auf Windows, ⌘ +S  auf Mac. Geben Sie einen Namen ein, wählen Sie ein Format (JPEG, TIFF, BMP oder PNG)

und legen Sie den Zielordner fest.

- Wenn Sie mit der Plugin-Version arbeiten:

Klicken Sie auf , um das Ergebnis anzuwenden und das Plugin-Fenster zu schließen. Das Plugin  AKVIS

Enhancer wird geschlossen und das bearbeitete Bild wird im Arbeitsbereich der Bildbearbeitungssoftware
angezeigt.

Rufen Sie das Dialogfeld Speichern unter mit dem Befehl Datei -> Speichern unter auf. Geben Sie einen Namen
für die Datei ein, wählen Sie ein Format und einen Zielordner aus.
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Details im Schatten = 50 Details im Schatten = 400

DETAILOPTIMIERUNG

Im Modus Detailoptimierung verdeutlicht das Programm die Zeichnung des Bildes, indem es den Farbübergang zwischen den
benachbarten Pixeln verstärkt. Auf diese Weise werden nicht nur Details im Schatten, sondern auch Details in den
überbelichteten Bereichen und in den Mitteltönen aufgedeckt.

Ergebnis nach der Detailoptimierung

 

Wählen Sie einen Wert für das Vorschaubild aus.

Der Parameter Vorschaubild ist ein Hilfswerkzeug. Die Größe des Originalbildes wird davon nicht beeinflusst. Es bleibt
unverändert und alle Details des Originals bleiben erhalten. Dieser Parameter ermöglicht es, die Vorbearbeitungsstufe zu
beschleunigen, falls man verschiedene Einstellungen ausprobieren möchte, um das beste Ergebnis zu erhalten.

Wenn die Option Hohe Qualität ausgewählt ist, werden die Verarbeitungsparameter auf das Bild in seiner Originalgröße
angewendet. Die Verarbeitungszeit wird erhöht, aber die Vorschauqualität wird so hoch wie möglich sein. Wenn Sie die Option
Schnell auswählen, ist die Vorschaugröße um das 8-fache kleiner als das Originalbild. Die Verarbeitungszeit wird entsprechend
verringert, aber das Ergebnis wird ungefähr sein. Bei Zwischenwerten ist die Vorschaugröße zwei- bis viermal kleiner als das
Originalbild.

Achtung! Nachdem Sie die Parameter angepasst haben, empfiehlt es sich, die weitere Bearbeitung mit der Option Hohe
Qualität auszuprobieren, um sicherzustellen, dass die besten Einstellungen ausgewählt wurden.

 

Passen Sie die Bildkorrekturparameter an. Alle Änderungen werden automatisch übernommen.

Details im Schatten (0-500). Der Parameter verstärkt die Schatten in dem Bild. Durch die Erhöhung dieses Wertes
werden dunkle Bereiche noch dunkler.

Details im Licht (0-500). Der Parameter hellt das Bild auf. Durch die Erhöhung des Wertes werden helle Bereiche noch
heller.
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Details im Licht = 50 Details im Licht = 400

 

Sättigung = -25

 

Sättigung = 25

 

Kontrast der Gradienten = 10

 

Kontrast der Gradienten = 50

 

Detailstufe = 5

 

Detailstufe = 45

Sättigung (-50..50). Der Parameter ändert die Farbintensität im Bild.

Kontrast der Gradienten (0-50). Der Parameter erlaubt es, den Kontrast des Bildes leicht zu erhöhen, um es
ausdrucksvoller zu machen.

Detailstufe (0-50). Der Parameter erlaubt es, die Detailgenauigkeit anzupassen. Je höher der Wert, desto schärfer ist
der Farbübergang und desto mehr Details werden angezeigt.

Schwellenwert (1-15). Der Parameter definiert, welche Details bei Erhöhung der Detailstufe hervorgehoben werden. Bei
niedrigen Werten werden alle Details im Bild verstärkt, bei hohen Werten werden kleine Details nicht geändert.
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Schwellenwert = 2

 

Schwellenwert = 10

 

Helligkeit = 5

 

Helligkeit = 20

Helligkeit (0-20). Der Parameter erlaubt es, dunkle Bereiche zu beleuchten. Je höher der Wert, desto heller wird das
Bild.
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Originalbild

 
Ergebnis

DRUCKVORBEREITUNG

Beim Drucken von Fotos, kann das Ergebnis auf dem Papier manchmal anders aussehen als auf Ihrem Monitor. Auf dem
Bildschirm können die Konturen von Objekten perfekt dargestellt werden, während auf dem Papier sie unscharf erscheinen. Um
dies zu vermeiden, kann das Bild vor dem Drucken bearbeitet werden.

Der Modus Druckvorbereitung verbessert die Schärfe der Konturen und erhöht den Kontrast des Bildes.

Folgen Sie der Anweisung:

Schritt 1. Wenn Sie diesen Modus gewählt haben, wird ein Teil des Bildes im Vorschaufenster in der Registerkarte
Ergebnis angezeigt.

Das Vorschaufenster ist ein gepunkteter Rahmen (diese punktierte Linie wird oft "marschierende Ameisen" genannt).
Ziehen Sie den Rahmen in die gewünschte Position auf dem Bild (Doppelklick mit der linken Maustaste) oder zeichnen ihn
aufs neue auf dem gewünschten Bereich, um diesen zu analysieren.

Um das vorläufige Ergebnis mit dem Originalbild zu vergleichen, klicken Sie auf das Vorschaufenster mit der linken
Maustaste und halten sie gedrückt.

Schritt 2. Zur Korrektur des Bildes stehen die folgenden Parameter zur Verfügung:

Die Parameter unter Schärfe verbessern die Detailgenauigkeit des Bildes.

Radius. Dieser Parameter nimmt Werte zwischen 0 und 100 an und bestimmt die Größe des Bereiches, in dem die
Konturen des Objektes verschärft werden. Bei hohen Werten können Halo-Artefakte entstehen. Der Standardwert
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ist 10.

Stärke. Dieser Parameter beeinflusst die Kontrastverstärkung entlang der Grenzen von Objekten. Je höher der
Wert des Parameters, desto klarer ist das Bild. Dieser Parameter wird vom Wert des Parameters Radius
beeinflusst. Er nimmt Werte von 0 bis 100 an. Der Standardwert ist 25.

Die Parameter unter Kontrast verbessern den Bildkontrast, indem helle Bereiche heller und dunkle Bereiche noch dunkler
gemacht werden.

Dunkle Bereiche. Dieser Parameter nimmt Werte zwischen -50 bis 100 an. Dieser Parameter verstärkt die
Schattenbereiche. Eine Erhöhung des Wertes wird dunkle Bereiche noch dunkler machen, während die
Verringerung des Wertes sie heller macht.

Helle Bereiche. Dieser Parameter nimmt Werte von -50 bis 100 an. Wenn Sie den Cursor nach rechts von 0
bewegen, werden die hellen Bereiche der Bilder noch heller. Verschieben Sie den Cursor nach links, erhöht sich die
Anzahl der Graustufen.

Schritt 3. Um das ganze Bild zu bearbeiten, klicken Sie auf .
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TONKORREKTUR

Der Modus Tonkorrektur wird für die Tonkorrektur von Bildern angewendet. Dabei wird die Helligkeit der Pixel in hellen und in
dunklen Bereichen so geändert, dass das Bild an Ausdruck gewinnt. Man kann das ganze Bild bearbeiten oder nur bestimmte
Farben auswählen, die Korrekturen brauchen.

Ergebnis nach der Tonkorrektur

Um ein Bild in diesem Modus zu bearbeiten, gehen Sie folgendermaßen vor:

Schritt 1. Wählen Sie den Modus Tonkorrektur in der Einstellungsleiste. Das Ergebnis wird im Vorschaufenster im
Register Original angezeigt.

Das Vorschaufenster ist ein gepunkteter Rahmen (diese punktierte Linie wird oft "marschierende Ameisen" genannt).
Standardmäßig werden in diesem Modus alle Einstellungen auf 0 gesetzt, sodass das Vorschaufenster zuerst ein nicht
verarbeitetes Bild anzeigt. Ziehen Sie den Rahmen in die gewünschte Position auf dem Bild (Doppelklick mit der linken
Maustaste) oder zeichnen ihn aufs neue auf dem gewünschten Bereich, um diesen zu analysieren.

Durch einen Klick mit der linken Maustaste außerhalb des Vorschaufensters können Sie vorübergehend auf die
Registerkarte Original umschalten und das Originalbild mit dem Ergebnis vergleichen.

Schritt 2. Wählen Sie die Farben der Bereiche, die korrigiert werden sollen (z.B. weil sie zu dunkel sind). Dazu
verwenden Sie eine der Farbpaletten. Die Hauptfarbpalette besteht aus sieben Farben. Darunter gibt es zwei weitere
Paletten, die jeweils aus drei Zellen bestehen. Sie können Farben aus der Hauptfarbpalette in diesen Zellen übertragen.
Auf diese Weise können Sie bis zu drei Farbpaletten bilden. Klicken Sie auf die Palette mit der linken Maustaste, um
diese zu aktivieren. Es werden nur die Punkte des Bildes korrigiert, die diese Farben haben. Die gewählte Farbpalette
wird weiß markiert.

AKVIS Enhancer

28



Der Farbenindikator hilft die passenden Farben für die Bildkorrektur auszuwählen.

Wenn Sie den Mauszeiger auf einen Bildpunkt stellen, werden eins bis drei dominierenden Farbkomponente für diesen
Punkt auf dem Farbenindikator angezeigt. Wenn Sie diesen Bereich korrigieren wollen, müssen Sie die entsprechenden
Farben auswählen (auf die aktive Farbpalette ziehen), damit sie bei der Bildkorrektur berücksichtigt werden.

Schritt 3. Passen Sie die Parameter für jede Palette an:

Radius. Dieser Parameter hat Werte von 0 bis 60 und bestimmt die Größe der Fläche um den analysierten Punkt
herum. Nach der Analyse bekommen die Punkte neue Helligkeits- und Farbwerte. Dann wird der Punkt weiter
bearbeitet.

Dunkle Bereiche. Der Standardwert dieses Parameters ist 0 und die dunklen Bereiche werden nicht korrigiert.
Wird der Wert des Parameters erhöht, so werden die dunklen Bereiche heller, und es sind mehr Details zu
erkennen. Die Objekte in den dunklen Bereichen werden sichtbarer.

Helle Bereiche. Standardmäßig ist der Wert dieses Parameters auf 0 gesetzt und Lichter werden nicht korrigiert.
Wird der Wert des Parameters erhöht, so werden die hellen Bereiche dunkler und das Bild gewinnt an Kontrast und
Volumen.

Hinweis: Für die Farben, die nicht zur Hauptfarbpalette gehören, ist die Anwendung der Parameter gemischt. Zum
Beispiel, wenn sich die Farben rot und gelb in verschiedenen Paletten befinden, werden bei der Korrektur der
orangen Farbe beide Palletten berücksichtigt.

Schritt 4. Um das Bild zu bearbeiten, klicken Sie auf .
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Ergebnis ohne Nachbearbeitung

 
Ergebnis mit Nachbearbeitung

NACHBEARBEITUNG

Für weitere Bildkorrektur verwenden Sie die Registerkarte Nachbearbeitung. Diese Registerkarte enthält ein Histogramm und
vier Einstellungen: Helligkeit, Kontrast, Gamma und Sättigung.

Ein Histogramm ist ein Diagramm, welches die Helligkeitsverteilung eines Bildes zeigt. Auf der Horizontale werden die
Helligkeitswerte angezeigt – von dunkel bis hell. Die Vertikale zeigt die Anzahl der Pixel, die denselben Helligkeitswert haben.

Unter dem Histogramm befinden sich drei Schieberegler, mit denen der Kontrast des Bildes verändert werden kann.

Der äußere rechte Punkt steht für die Pixel, die das Maximum an Helligkeit besitzen (weiße Stellen). Enthält das Histogramm
keine solchen Pixel, dann enthält das Bild keine weißen Stellen. Wenn man den weißen Schieberegler nach links bewegt,
übernimmt der Punkt, gegen den der Regler verschoben wird die maximale Helligkeit (255) und die Pixel, die diesen Wert
besitzen, werden weiß. Die Helligkeit der anderen Pixel wird entsprechend neuberechnet, wodurch das gesamte Bild heller
wird.

Der äußere linke Punkt steht für die Pixel, die das Minimum an Helligkeit besitzen (schwarze Stellen). Enthält das Histogramm
nicht ganz links beginnt, dann enthält auch das Bild keine schwarzen Pixel (Helligkeit = 0). Wenn man den schwarzen
Schieberegler nach rechts bewegt, übernimmt der Punkt, gegen den der Regler verschoben wird, den minimalen
Helligkeitswert. Im Ergebnis wird diese Tönung schwarz, während die anderen Pixel entsprechend neuberechnet werden. Das
Bild wird dunkler.

Der Schieberegler in der Mitte definiert die Tönungen des Bildes, die eine Helligkeit von 128 haben (Mitteltöne). Wenn Sie den
Regler nach links bewegen, werden die mittleren Grautöne heller. Wenn Sie ihn nach rechts bewegen, werden diese Töne
dunkler.

Rechts oberhalb des Histogramms befindet sich eine Drop-down-Liste mit Bildkanälen:  RGB, Rot, Grün, Blau, Farben,
Lichtstärke. Es ist möglich, diese Kanäle einzeln oder gesamt zu korrigieren.

 

In der Registerkarte Nachbearbeitung können Sie die folgenden Einstellungen anpassen.

Helligkeit. Mit den Helligkeitseinstellungen wird die Helligkeit des Bildes verändert. Hier sind Werte zwischen -100 und
100 möglich, der Vorgabewert ist 0. Je höher der Wert eingestellt wird, umso heller werden die Pixel des Bildes und
umgekehrt.
Kontrast. Der Parameter erhöht (bei Werten größer als 0) oder verringert (bei Werten unter 0) den Unterschied
zwischen den hellen und dunklen Bereichen des Bildes. Der Standardwert ist 0.
Gamma. Der Parameter beeinflusst den Gesamtkontrast des Bildes, indem die Mitteltöne (Graustufen) manipuliert
werden. Der Standardwert ist 100.
Sättigung. Der Parameter verändert die Farbintensität eines Bildes. Standardmäßig ist dieser Wert auf 0 gesetzt.

Alle Einstellungen, die Sie in diesem Register verändern, werden automatisch angewandt. Das Resultat wird im Register
Ergebnis angezeigt.
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STAPELVERARBEITUNG

AKVIS Enhancer unterstützt Stapelverarbeitung. Diese Technik gibt Ihnen die Möglichkeit, die gleichen Einstellungen auf
einen Ordner voller Fotos anzuwenden und sich damit viel Zeit zu sparen.

Stapelverarbeitung ist für alle Modi des Programms verfügbar. Sie brauchen nur einmal die Einstellungen anzupassen und
danach wird das Programm den ganzen Stapel der Fotos automatisch bearbeiten.

Es geht ganz einfach: Anbei ist die Anleitung für die Standalone-Version. Wenn Sie eine Plugin-Version haben, klicken Sie
hier.
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STAPELVERARBEITUNG MIT PHOTOSHOP PLUGINS

Die Plugins von AKVIS unterstützen die Automatisieren-Funktion in Adobe Photoshop.

Stapelverarbeitung ist sehr nützlich und zeitsparend, wenn Sie eine Reihe von Fotos bearbeiten möchten. Diese Funktion
wendet die gleichen Einstellungen von AKVIS OilPaint auf einen Ordner mit Bildern an.

Selbst wenn Sie Stapelverarbeitung bisher noch nie benutzt haben, wird es Ihnen keine Mühe kosten, sich damit
zurechtzufinden. Man muss eine Aktion anlegen und anschließend die Aktion auf das Verzeichnis anwenden, in dem sich die
Bilder befinden.

Folgen Sie der Anleitung:

Schritt 1. Erstellen Sie auf Ihrer Festplatte 2 Verzeichnisse: "Ausgangsdateien" und "Ergebnisdateien". Kopieren Sie Ihre
Fotos zur Bearbeitung in den Ordner "Ausgangsdateien". Bearbeitete Fotos werden in dem Ordner "Ergebnisdateien"
gespeichert.
Schritt 2. Öffnen Sie eines der Originalfotos in  Adobe Photoshop. Wir werden dieses Foto benutzen, um die
Einstellungen von AKVIS OilPaint anzupassen und eine Aktion zu erstellen.

Schritt 3. In der Aktionen-Palette klicken Sie auf die Schaltfläche Neuen Satz erstellen. In dem erscheinenden
Fenster geben Sie einen Namen für das neue Set von Aktionen ein, z.B. "AKVIS".

Wenn Sie bereits ein Set für AKVIS Aktionen haben, können Sie es einfach auswählen.

Neues Set in der Palette Aktionen anlegen

Schritt 4. Klicken Sie auf das Symbol Neue Aktion erstellen und geben Sie einen Namen für die Aktion ein, z.B. "Oil".
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Neue Aktion

Klicken Sie auf den Button Aufzeichnung beginnen, sodass die Aufnahme der Aktion startet.

Schritt 5. Rufen Sie das Plugin auf und passen Sie die Einstellungen an.
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Schritt 6. Klicken Sie auf . Das Plugin-Fenster wird geschlossen und der Effekt wird auf das Bild angewendet. In der

Aktionen-Palette wird eine neue Zeile mit dem Namen des Plugins angezeigt.

Schritt 7. Die Aktion wird immer noch aufgezeichnet. Wählen Sie im Menü Datei den Eintrag Speichern als und
speichern Sie das Bild im Verzeichnis "Ergebnisdateien" ab.
Schritt 8. Stoppen Sie die Aufnahme der Aktion, indem Sie den Button Ausführen/Aufzeichnen beenden drücken,
den Sie am Boden der Aktionen Palette finden.

Schritt 9. Löschen Sie die Datei, die Sie gleich im Verzeichnis "Ergebnisdateien" abgespeichert haben.
Schritt 10. Die Aktion ist angelegt und Sie können somit mit der Stapelverarbeitung der Videobilder fortfahren. Wählen
Sie unter Datei den Befehl Automatisieren -> Stapelverarbeitung.
Schritt 11. In dem Stapelverarbeitung-Fenster passen Sie die Einstellungen an:

Wählen Sie im Feld Satz "AKVIS" und die neue Aktion.

Im Feld Quelle legen Sie den Ordner  fest. Drücken Sie auf  Wählen... und wählen Sie den Ordner
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"Ausgangsdateien" aus.

Solange Sie noch nicht den Befehl ‚Datei öffnen’ in der Aktion ausgeführt haben, sollte das Kästchen "Dateien
nur speichern, wenn Aktionsset Befehl "Speichern" oder "Speichern unter" enthält" deaktiviert werden.

Wählen Sie für das Feld Ziel den Eintrag Ordner, drücken Sie anschließend Wählen... und wählen Sie den Ordner
"Ergebnisdateien" aus.

Aktivieren Sie das Kästchen "Dateien nur speichern, wenn Aktionsset Befehl "Speichern" oder "Speichern
unter" enthält".

Im Segment zur Dateibenennung geben Sie die Namenstruktur für die zu bearbeitenden Bilder an. Damit die
Bilder nicht umbenannt werden, wählen Sie Dokumentenname im ersten Feld und Erweiterung im zweiten Feld.

Schritt 12. Drücken Sie auf OK-Button, um die Stapelverarbeitung zu starten. Photoshop wendet das Plugin auf alle
Fotos in dem "Ausgangsdateien"-Ordner an und speichert die bearbeiteten Bilder in dem "Ergebnisdateien"-Ordner.
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OPTIONEN

Die Schaltfläche   ruft das Dialogfenster Optionen auf. Es sieht so aus:

Sprache. Wählen Sie die gewünschte Sprache aus dem Menü aus.
Skalierung des Interfaces. Passen Sie die Größe der Schnittstellenelemente an. Wenn die Auto-Option ausgewählt
wird, erfolgt eine automatische Skalierung des Interfaces auf Basis der Bildschirmauflösung.
Schnittstelle. Wählen Sie den gewünschten Stil des Interfaces: Hell oder Dunkel.
Skalierung. Dieser Parameter definiert, wie das Bild im Bildfenster nach dem Öffnen skaliert wird. Es gibt zwei
Möglichkeiten:

- Ans Fenster anpassen. Das Bild wird so skaliert, dass es vollständig ins Bildfenster passt;
- Bei der Option 100% wird das Bild nicht skaliert. Beim Maßstab = 100% wird nur ein Teil des Bildes sichtbar.

Die Größe des Vorschaufensters.  Wählen Sie den gewünschten Wert des Parameters.  Die Größe des
Vorschaufensters kann die Werte von 300х300 bis 1000х1000 Px annehmen. Das Vorschaufenster wird für die Modi
Druckvorbereitung und Tonkorrektur verwendet.
Zuletzt verwendete Dateien (nur in der Standalone-Version). Legen Sie die Zahl der zuletzt geöffneten Dateien fest,
die mit einem Rechtsklick auf  angezeigt werden. Maximum: 30 Dateien.

Hinweise anzeigen. Wenn Sie über die Parameter oder Schaltflächen mit der Maus gehen, wird im Feld Hinweise eine
kurze Beschreibung des jeweiligen Elements angezeigt. Sie können bestimmen, wo die Hinweise erscheinen:

- Unter dem Bildfenster.
-  Unter den Einstellungen.
-  Ausblenden.

Kästchen Optionsleiste fixieren. Es deaktiviert die Möglichkeit, die Optionsleiste ein- und auszublenden. Wenn das
Kästchen ausgewählt ist, wird dieses Panel immer angezeigt.
Kästchen GPU Beschleunigung. Wenn das Kästchen aktiviert ist, beschleunigt dieser Modus die Bearbeitung mithilfe
des Graphikprozessors. Wenn Ihr Computer diese Möglichkeit nicht unterstützt, bleibt das Kästchen grau (nicht
verfügbar).

Um diese Optionen zu speichern, klicken Sie auf OK.

Klicken Sie auf Standard, um die Standardeinstellungen wiederherzustellen.
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DRUCKEN VON BILDERN IN AKVIS ENHANCER

Die eigenständige Version von AKVIS Enhancer erlaubt das Drucken des Bildes.
Klicken Sie auf die Schaltfläche  , um die Druckeinstellungen anzupassen.

Druckeinstellungen in AKVIS Enhancer

Passen Sie die Parameter in der Einstellungsleiste an:

Wählen Sie aus der Liste der verfügbaren Drucker den gewünschten Drucker aus. Legen Sie die Anzahl der zu
druckenden Kopien sowie die gewünschte Auflösung fest.

In der Parametergruppe Orientierung legen Sie die Orientierung des Bildes beim Drucken fest: Porträt (vertikal) oder
Album (horizontal).

Klicken Sie auf die Schaltfläche Seiteneinstellungen, um das Dialogfeld zu öffnen, in dem Sie die Seitengröße, die
Orientierung der Seite beim Drucken und die Breite der Kanten festlegen können.

Klicken Sie auf die Schaltfläche Ränder zurücksetzen, um die Standardeinstellungen wiederherzustellen.

Die Parameter Maßstab, Breite und Höhe und das Kästchen Auf Mediengröße skalieren legen die Druckgröße des
Bildes fest. Sie beeinflussen nicht das Bild selbst, sondern seine gedruckte Kopie. Es ist möglich, die Größe der
gedruckten Kopie zu ändern, indem man den Maßstab in Prozent festlegt (ein Wert unter 100% verringert das Bild, ein
Wert über 100% vergrößert es) oder indem man neue Werte für Breite und Höhe einträgt.

Um das Bild auf die ausgewählte Papiergröße zu skalieren, aktivieren Sie das Kästchen Auf Mediengröße skalieren.

Verschieben Sie das Bild mit der Maus oder mit den Pfeiltasten.

Sie können das zu druckende Bild mit einem Rahmen versehen. Die Breite und Farbe des Rahmens sind einstellbar.

Wählen Sie eine Hintergrundfarbe durch einen Klick auf das Farbmuster.

In dem Seite-Register können Sie mehrere Seiten auf ein Blatt Papier drucken lassen.
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Seite drucken

Kopien pro Blatt. Legen Sie fest, wie viele Kopien des Bildes auf ein Blatt Papier gedruckt werden.
Horizontal und Vertikal. Diese Parameter bestimmen, in wie vielen Spalten und Zeilen die Kopien des Bildes
dargestellt werden.
Abstand. Der Parameter stellt den Abstand zwischen den Kopien des Bildes ein.

In dem Poster-Register können Sie ein Bild auf mehrere Blätter verteilt ausdrucken und die Ausdrücke zu einem großen
Poster zusammenfügen.

Poster drucken

Blätter. Wenn das Kontrollkästchen aktiviert ist, können Sie die maximale Anzahl der Blätter festlegen, auf die das
Bild gedruckt wird. Das Bild wird so skaliert, dass es auf die gewünschte Anzahl Druckseiten passt. Wenn das
Kontrollkästchen deaktiviert ist, wird das Programm eine optimale Blattanzahl entsprechend der tatsächlichenKontrollkästchen deaktiviert ist, wird das Programm eine optimale Blattanzahl entsprechend der tatsächlichen
Bildgröße (Maßstab = 100%) automatisch auswählen.
Kleberänder. Aktivieren Sie dieses Kontrollkästchen, um die Breite der Kleberänder einzustellen. Die Ränder
werden rechts und unten gesetzt.
Schnittlinien. Aktivieren Sie dieses Kontrollkästchen, um die Schnittmarkierungen zu drucken. Sie helfen Ihnen
beim Zusammensetzen des Bildes.
Seitenzählung. Aktivieren Sie dieses Kontrollkästchen, um jedes Bildteil zu nummerieren. Nummer der Zeile und
Spalte wird am Rand gedruckt.
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Um den Druckprozess zu starten, klicken Sie auf die Schaltfläche Drucken. 
Um das Dialogfeld ohne Drucken des Bildes zu schließen, klicken Sie auf Abbrechen.

Klicken Sie auf die Schaltfläche  Eigenschaften..., um ein Systemdialogfeld zu öffnen, wo Sie erweiterte Einstellungen
anpassen und das Dokument drucken können.
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Originalbild

 
Ergebnis

TONKORREKTUR: FRISCHE ERDBEEREN

Im Modus Tonkorrektur von AKVIS Enhancer können Sie die Helligkeit einer bestimmten Farbe anpassen.

Wir werden dies auf einem Foto der Erdbeeren zeigen.

Öffnen Sie das Bild.

Zuerst wollen wir die Farbe der Beeren auffrischen. Dafür wählen Sie rot aus der Hauptfarbpalette und ziehen die Farbe auf
die untere Farbpalette.

Die ausgewählte Farbpalette wird weiß markiert. Passen Sie die Parameter wie folgt an:

Erhöhen Sie den Wert des Parameters Highlights bis 70, und Radius bis 45. Die Beeren werden dunkler und reifer, die Farbe
der Blätter hat sich nicht geändert.

Jetzt machen wir die Farbe der Blätter etwas dunkler. Ziehen Sie die grüne Farbe auf die andere Farbpalette.
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Für die grüne Farbe, erhöhen wir den Wert von Highlights bis 90.

Klicken Sie auf , um das ganze Bild zu bearbeiten. Die Farben sind frischer geworden und das Bild ausdrucksvoller.

Auf diese Weise können Sie ausgewählte Farben auf dem Bild satter oder weicher erscheinen lassen.
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Originalbild

 

Ergebnis

EISWÜRFEL

Wenn das ausgedruckte Bild nicht optimal aussieht, versuchen Sie es im Modus Druckvorbereitung von AKVIS Enhancer zu
bearbeiten, und Ihr Bild wird ganz schnell an Deutlichkeit gewinnen.

Für dieses Beispiel haben wir ein Foto mit Eiswürfeln genommen. Das Bild ist nicht schlecht, aber etwa nebelig, undeutlich.

Klicken Sie auf das Bild, um es zu vergrößern

Schritt 1. Starten Sie AKVIS Enhancer und öffnen das Ausgangsbild. Wählen Sie den Modus Druckvorbereitung.

Schritt 2. Im Vorschaufenster wird mit den Standardeinstellungen bearbeitete Bild angezeigt. Wir passen die
Parameter wie folgt an:

Schritt 3. Klicken Sie auf , um das ganze Bild zu bearbeiten.

Das Bild ist so gestochen scharf, dass man sogar die kleinsten Tropfen sehen kann.
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Klicken Sie auf das Bild, um es zu vergrößern
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Original

 
Ergebnis

AUF DER STRASSE

Wenn Sie ein Foto auf der Straße bei schlechter Beleuchtung aufnehmen, kann das Motiv der Aufnahme zu dunkel und kaum
sichtbar sein. Sie können die Details im Schatten mithilfe des Modus Detailoptimierung in AKVIS Enhancer hervorheben.

Zur Verbesserung dieses Bildes wurde das Plugin AKVIS Enhancer verwendet, aber Sie können dasselbe Ergebnis mithilfe der
eigenständigen Version des Programms erzielen.

Schritt 1. Öffnen Sie das Foto in einer Bildbearbeitungssoftware, z.B. in AliveColors. Oder starten Sie die Standalone-
Version von Enhancer.

Schritt 2. Rufen das Plugin AKVIS Enhancer auf. Dazu wählen Sie den entsprechenden Befehl: in AliveColors Effekte
-> AKVIS -> Enhancer, in Adobe Photoshop Filter -> AKVIS -> Enhancer, in Corel PaintShop Pro Effects -> Plugins -
> AKVIS -> Enhancer.

Wählen Sie den Modus Detailoptimierung. Das Foto wird automatisch mit dem zuletzt verwendeten Preset bearbeitet.
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Schritt 3. Da das Foto unterbelichtet ist, müssen wir mehr Details im Schatten hervorheben. Erhöhen Sie den Wert des
Parameters Helligkeit und passen Sie die anderen Parameter so an, um die gesamte Helligkeit und Schärfe des Bildes zu
verbessern.

Schritt 4. Wenn Sie die Plugin-Version benutzen, wenden Sie das Ergebnis der Fotobearbeitung durch einen Klick auf die
Schaltfläche   an.
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AKVIS SOFTWARE

 

AKVIS AirBrush — Airbrush-Technik in Fotos

AKVIS AirBrush lässt Ihre Fotos wie mit einer Spritzpistole gezeichnet aussehen. Weiter…

 

AKVIS Artifact Remover AI — JPEG-Kompressionsartefakte beseitigen

AKVIS Artifact Remover AI verwendet fortgeschrittene Algorithmen der künstl ichen Intell igenz, um JPEG-
Kompressionsartefakte zu entfernen und die ursprüngliche Qualität komprimierter Bilder wiederherzustellen. Die Software ist
kostenlos erhältlich. Es ist ein Muss für Heimanwender und Profis. Weiter…

 

AKVIS ArtSuite — Bilderrahmen und Effekte für Ihre Fotos

AKVIS ArtSuite versieht Digitalfotos mit schönen Bilderrahmen. Ein richtig ausgewählter  Bilderrahmen ergänzt Ihr Bild und
bringt es zur besonderen Geltung. 
Das Programm stellt eine große Auswahl unterschiedlichster Rahmen bereit.  Außerdem erlaubt es, eigene Bilder für die
Erstellung des originellen Rahmens zu benutzen. Weiter…
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AKVIS ArtWork — Vielseitige Sammlung von Maltechniken

AKVIS ArtWork imitiert verschiedene Mal- und Zeichentechniken. Das Programm bietet diese Stilmöglichkeiten an: Ölgemälde,
Aquarell, Gouache, Comic, Tintenzeichnung, Linolschnitt, Pastell und Pointill ismus. Ob ein Ölporträt oder eine
Landschaftsmalerei, das Programm wird Ihre Ideen erfolgreich umsetzen. Weiter…

 

AKVIS Chameleon — Erstellung von Fotocollagen

AKVIS Chameleon ist ein wunderbares Programm für Erstellung von Fotocollagen mit automatischer Adaptierung der
eingesetzten Objekte in Bezug auf die Farbe des Hintergrundes sowie deren Kantenglättung. Das Programm erfordert nicht die
exakte Auswahl der Objekte. Kopieren Sie das Objekt, setzen Sie es in das Bild ein, und er adaptiert die Farbskala des Bildes
und seine Ränder glätten sich. Weiter…
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AKVIS Charcoal — Kohle- und Kreidezeichnungen

AKVIS Charcoal ist ein künstlerisches Werkzeug zur Umwandlung von Fotos in Kohle-, Kreide- und Rötelzeichnungen. Weiter…

 

AKVIS Coloriage — Bildeinfärbung und Farbenänderung

AKVIS Coloriage ändert die Farben eines Fotos: von der Einfärbung Schwarz-Weiß-Fotos bis hin zur Farbenänderung auf Ihren
Farbfotos.
Kein Hantieren mit Ebenen - malen Sie einfach ein paar Striche mit den gewünschten Farben und das Programm erledigt den
Rest. Weiter…

 

AKVIS Decorator — Oberflächengestaltung und Farbveränderung

AKVIS Decorator erlaubt es, die Oberfläche eines Objekts zu verändern. Wählen Sie einen Teil des Bildes aus, z.B. das Kleid
eines Mädchens, und wenden neue Texturen darauf an. Das Mädchen bekommt ein geflecktes oder kariertes Kleid, das
aussieht als wäre es aus Samt oder Seide, oder sogar aus Holz oder Süßigkeiten. Weiter…
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AKVIS Draw — Skizzeneffekt in Fotos

AKVIS Draw lässt Fotos wie mit einem Bleistift gezeichnet aussehen. Die Software funktioniert wie ein Kunstfilter, der Fotos in
stilvolle Skizzen durch Anpassung der Einstellungen umwandelt. Weiter…

 

AKVIS Enhancer — Bildkorrektur und Detailoptimierung

AKVIS Enhancer ist ein Werkzeug, um Bilder zu retten, die wegen falscher Belichtung nicht optimal aussehen. Das Programm
gibt Ihnen die Möglichkeit, Details in unterbelichteten und überbelichteten Bereichen eines Fotos aufzudecken. Das Programm
hat drei Modi: Detailoptimierung, Druckvorbereitung und Tonkorrektur. Weiter…

 

AKVIS Explosion — Spektakuläre Explosionseffekte

AKVIS Explosion bietet kreative Zerstörungs- und Explosionseffekte für digitale Fotos. Das Programm imitiert den Sandsturm-
Effekt und fügt Ihren Bildern fliegende Partikel hinzu. Mit der Software können Sie Ihre Entwürfe ganz einfach explodieren
lassen! Weiter…
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AKVIS Frames — Farbenfrohe digitale Fotorahmen

AKVIS Frames ist eine kostenlose Foto-Editing-Software, die speziell für die Arbeit mit Rahmenpaketen von AKVIS entwickelt
wurde. Mit dem Programm können Sie Ihre Fotos mit exklusiven Bilderrahmen schnell und einfach versehen! Weiter…

 

AKVIS HDRFactory — HDR-Bilder: Über die Wirklichkeit hinaus

AKVIS HDRFactory ist ein vielseitiges Programm zum Erstellen von HDR-Bildern sowie für kreative Gestaltung der Fotos.
HDRFactory erstellt HDR aus mehreren Aufnahmen des gleichen Objekts mit unterschiedlichen Belichtungszeiten. HDRFactory
erlaubt es Ihnen, sogar den HDR-Effekt auf einem Bild nachzuahmen. Das Programm kann auch für Fotokorrektur verwendet
werden. Weiter…

 

AKVIS LightShop — Licht- und Sterneneffekte

AKVIS LightShop erlaubt es Ihnen, eine endlose Zahl von erstaunlichen Lichteffekten zu erstellen! Das Programm bietet
fortgeschrittene Techniken zur Erstellung von Sternen- und Lichteffekten auf Ihren Fotos. Ein Lichteffekt kann jedes Foto
beleben und auffrischen. Fügen Sie Ihren Fotos einen Hauch von Magie hinzu! Weiter…
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AKVIS Magnifier AI — Bilder vergrößern ohne Verluste

AKVIS Magnifier AI erlaubt es, Fotos zu vergrößern, ohne dass das Bild an Schärfe verliert.

Wenn Sie kleine Bilder haben, die Sie gerne in einer besseren Auflösung hätten, um diese zu drucken, ist das ein Werkzeug für
Sie! Weiter…

 

AKVIS MakeUp — Porträtverbesserung

AKVIS MakeUp ist eine Software zur Porträtverbesserung, die Ihren Fotos einen professionellen Look verleiht.

Die Software verfeinert die Hautstruktur auf Porträtaufnahmen und lässt den Teint strahlen. Es ist schon erstaunlich, wie viel
ein gutes Hautbild zum Verjüngen und Auffrischung des Gesichts beibringen kann. Weiter…
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AKVIS NatureArt — Natur-Effekte auf digitalen Fotos

AKVIS NatureArt ist ein ausgezeichnetes Werkzeug zur Nachahmung der Schönheit der Naturphänomene auf Ihren digitalen
Fotos. Das Programm enthält eine ganze Reihe von Effekten: Regen

 

AKVIS Neon — Leuchtbilder aus Fotos

AKVIS Neon ist eine Software zur Umwandlung von Fotos in leuchtende Zeichnungen. Das Programm transformiert Fotos in
Neonbilder, die wie mit fluoreszierenden Farben gezeichnet aussehen. Weiter…

 

AKVIS Noise Buster AI — Verringerung des Bildrauschens

AKVIS Noise Buster AI verringert Rauschen auf digitalen Bildern. Das digitale Rauschen kann als zahlreiche helle, dunkle oder
farbige Bildpunkte auf einfarbigen Flächen auftreten. Nach der Anwendung sehen Ihre Fotos sauber und fehlerfrei aus. Weiter…
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AKVIS OilPaint — Ölgemälde-Effekt

AKVIS OilPaint lässt digitale Fotos wie echte Ölgemälde aussehen. Die geheimnisvolle Herstellung eines Gemäldes geschieht
direkt vor Ihren Augen. Der einzigartige Algorithmus erlaubt es, die Technik eines echten Pinsels authentisch zu reproduzieren.
Mit dieser innovativen Software können Sie ein richtiger Künstler werden! Weiter…

 

AKVIS Pastel — Pastellgemälde aus Fotos

AKVIS Pastel verwandelt Ihre Fotos in Pastellgemälde. Das Programm konvertiert Ihre Bilder in lebensechte digitale
Kunstwerke, indem es eine der beliebtesten künstlerischen Maltechniken imitiert. AKVIS Pastel ist ein leistungsfähiges
Werkzeug, um Ihr kreatives Potenzial zu entdecken und auszuleben! Weiter…

 

AKVIS Points — Pointillismus-Effekt in Fotos

AKVIS Points verwandelt Ihre digitalen Fotos in Gemälde in pointillistischer Malweise. Diese Technik zählt zu einer der
ausdrucksstärksten Stilrichtungen in der Malerei. Entdecken Sie Geheimnisse des Pointillismus mit AKVIS Points! Weiter…
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AKVIS Refocus AI — Scharfstellung und Weichzeichnung

AKVIS Refocus AI stellt verschwommene Bilder scharf. Das Programm kann das ganze Foto oder nur einen ausgewählten Teil
davon in den Fokus stellen, damit das Aufnahmemotiv besser zur Geltung kommt. Außerdem ist es möglich, Bokeh- und
Weichzeichnungseffekte auf Ihre Fotos zu erstellen.

Die Software stellt fünf Modi zur Verfügung:  Scharfstellung AI, Iris-Weichzeichnung, Tilt-Shift, Bewegungsunschärfe und
Radiales Weichzeichnen. Weiter…

 

AKVIS Retoucher — Software zur Fotorestaurierung

AKVIS Retoucher ist eine effektive Fotorestaurierungssoftware für Kratzer-und Staubbeseitigung. 
Die Software hilft nicht nur Kratzer, Risse, Schmutz und sonstige Beschädigungen zu beseitigen, sondern auch die fehlenden
Teile des Fotos zu rekonstruieren, indem die angrenzenden Bereiche zur Wiederherstellung herangezogen werden. Weiter…
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AKVIS Sketch — Fotos in Zeichnungen umwandeln

AKVIS Sketch verwandelt Fotos in hochrealistische Bleistiftzeichnungen. Die Software erstellt wunderschöne S/W und farbige
Zeichnungen, die die Technik der Graphit-, Bleistift-, Kohle-, Pastell- und Aquarellzeichnung nachahmen. Das Programm bietet
drei Stile: Klassischen, Künstlerischen und Maestro - jeweils mit einer Reihe von Voreinstellungen. Mit AKVIS Sketch brauchen
Sie keinen Bleistift, um sich als Künstler zu fühlen! Weiter…

 

AKVIS SmartMask — Objekte aus Foto ausschneiden

AKVIS SmartMask ist ein Maskierungswerkzeug, das die Auswahl schwieriger Objekte innerhalb weniger Sekunden erlaubt,
ohne sie genau zu markieren.

Nie war die Auswahl so einfach! Weiter…

 

AKVIS Watercolor — Aquarell-Effekt auf Fotos

AKVIS Watercolor verwandelt Fotos in erstaunlich realistische Aquarellbilder. Das Programm erlaubt es, großartige
Meisterwerke mit nur einem Klick erstellen! Weiter…
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